Implementing Recovery-Oriented, Evidence-Base Care for Schizophrenia

by Alex Young, MD and Amy Cohen, Ph.D.

The President’s New Freedom Commission revealed pervasive problems in the U.S. mental health system. The VA has responded with the Comprehensive Mental Health Strategic Plan and Uniform Services Package focused on evidence-based and recovery-oriented services. In schizophrenia, outcomes are substantially improved with appropriate use of psycho-social and medication treatments, including medication to manage symptoms, supported employment, caregiver services, and wellness counseling.

Enhancing Quality of care In Psychosis

(EQUIP; PI Alexander Young, MD, MSHS, Co-PI Amy Cohen, Ph.D.) is funded by the VA HSR&D Quality Enhancement Research Initiative (QUERI). EQUIP is a collaboration between clinicians, researchers, and policy-makers in four VA networks (VISNs) to implement evidence-based care for schizophrenia, and to evaluate this implementation in a controlled trial. EQUIP draws on implementation science, evidence-based quality improvement, and implementation research in schizophrenia to guide implementation. The EQUIP care model identifies individuals who would benefit from a specific service and reorganizes care to ensure that these services are accessible.

To date, specialty mental health programs at eight medical centers have been enrolled and assigned to usual care or an intervention supporting implementation of recovery-oriented, evidence-based practices.

Each of the four participating VISNs chose two practices to be the focus of implementation efforts.

Cont’d on Page 5

Also See: Letter From The Director on Page 2

MIRECC 22 Retreat

by Stephen Marder, MD

MIRECC investigators have been challenged with trying to interpret large and complex data sets. Strategies for addressing these challenges were presented during a MIRECC retreat titled “New Approaches to Making Sense Out of Your Data” on September 16-17. The session was organized and chaired by Catherine Sugar, Ph.D., the head of the MIRECC Data Core and featured presentations by Data Core faculty and staff as well as their colleagues at SIStat, the data and statistics unit in the UCLA Semel Institute for Neuroscience and Human Behavior.

The retreat included talks on both qualitative and quantitative methods. In the first category, Brian Mittman and Alison Brown spoke about evaluation of implementation strategies and Beth Bromley and Joel Braslow discussed anthropological evaluation methods using examples from a recent study on implementing a recovery model in the Los Angeles Department of Mental Health.

Cont’d on Page 6
Letter From The Director

Stephen R. Marder, MD

Quality of Care

Many of us in the VA are excited about the implementation of the Comprehensive Mental Health Strategic Plan and Uniform Services Package. It represents a commitment to providing quality comprehensive care throughout the VA. However, improving care in psychiatric and other illnesses requires substantially more than publishing new and higher standards of care. It requires practitioners throughout the system to change their practices and – in some cases – to add to their current set of skills. The research program described by Dr. Alex Young in this issue describes an approach to changing what providers actually do.

One of the important findings in studies aimed at improving the quality of care is that just educating providers with lectures is relatively ineffective. In other words, clinicians may learn new information at lectures, but this new information may not change what they actually do when they see a patient.

The EQUIP (Enhancing Quality of care In Psychosis) program changes what providers actually do in a VA clinical setting. It uses innovative methods to assess the needs of individuals and assures that the results of the assessments lead to evidence based interventions. An early study by Drs. Young and Cohen indicated that the EQUIP intervention is more effective than usual VA care. As noted in the article, this intervention is now being studied in eight VA Medical Centers in four VISNs.

MIRECC 22 Unit Reviews—Treatment Unit

At the semi-annual meeting of the MIRECC executive committee held on May 27, 2008 in Long Beach, we reviewed activities of each of the scientific units and discussed various educational goals for the next year. We continue in this issue to highlight the different unit activities.

The next two Units to discuss their activities will be the Treatment and the Data Core Units.

The Treatment Unit Director is Michael F. Green, Ph.D., and the Medical Director is Stephen R. Marder, MD.

The activities of the Treatment Unit can be divided into studies of psychopharmacology and studies of psychosocial interventions. For psychopharmacology, the Treatment Unit helps to support the Los Angeles performance site of the NIMH-network TURNS (Treatment Units for Research on Neurocognition and Schizophrenia). This network includes seven sites (Los Angeles is the coordinating site) and has two clinical trials ongoing to evaluate innovative drugs for the treatment of cognitive impairment in schizophrenia. This network will continue to explore promising agents after NIMH support ends by obtaining grants from pharmaceutical companies.

The Treatment Unit is also involved in a new validation study sponsored by an NIH / industry / academic consortium called MATRICS-CT (MATRICS - Co-primary and Translation).

Cont’d on Page 6

VISN 22 VA Desert Pacific Healthcare Network Mental Illness Research, Education and Clinical Center
The Data Core Unit Interim Director is Catherine Sugar, Ph.D.

The Data Core’s mission is to provide statistical, data management and information technology services to MIRECC faculty and fellows. We can help with every stage of the research process including experimental design, methodological development, grant writing, creation of secure data entry and storage systems, data collection, web site development, statistical consulting, data analysis, and preparation of presentations. In addition to its own staff, the Data Core, through its connection with SIStat, the statistics core in UCLA’s Semel Institute for Neuroscience and Human Behavior (also directed by Dr. Sugar), has access to a wide range of faculty experts in biostatistics. We can provide assistance with a wide range of classical and modern analytical techniques including power and sample size calculations, experimental design, missing data, clustering, classification, CART, data mining, bioinformatics, genetics, factor analysis, structural equation modeling, survival analysis, nonparametric methods, and statistical modeling including multivariate linear and logistic regression, mixed effects, longitudinal and repeated measures models and hierarchical and non-linear techniques.

On the programming side, Data Core staff are experienced at creating customized secure web based randomization, data entry and database systems for large scale studies and can create specialized quality assurance and analytical software. They maintain the MIRECC website and can build public and private portals for individual studies.

On the programming side, Data Core staff are experienced at creating customized secure web based randomization, data entry and database systems for large scale studies and can create specialized quality assurance and analytical software. They maintain the MIRECC website and can build public and private portals for individual studies.

Peer Specialist Training and Certification

by Stacey E. Maruska, LISW

In an effort to meet the requirements of the Uniform Mental Health Services for VA Facilities and Clinics, VISN 22 MIRECC provided funding to train 17 peer providers to become certified Peer Specialists. Seventeen peer providers from VISNs 7, 18, 21, and 22 attended a 4.5-day training in Long Beach, CA from September 27 – October 3, 2008.

The VA has focused efforts to identify and engage veteran consumers as partners with clinicians and administrators in the design, evaluation and implementation of recovery-oriented, person centered services. Veteran peers are taking on a variety of responsibilities throughout VA facilities through a newly created position titled Peer Support Technician, and through volunteer operated peer support programs that serve as an adjunct to clinical services and help reach more veterans in need of care. Trained veteran peers use the power of their recovery experiences to support, encourage, and model recovery from mental illness. Such individuals are a beacon of hope and encouragement to others living with mental illnesses.

Depression and Bipolar Support Alliance (DBSA) was contracted to provide expert trainers using a well developed curriculum grounded in recovery principles to train peer providers. DBSA has provided this training at other VA sites across the nation including VISNs 12 and 15. In an effort to develop a trained peer workforce, DBSA offers consultation, training and technical assistance to the VA nationally.
**Spotlight on MIRECC 22 Staff ~ Beatriz Perez**

During Beatriz’s eight year career with the VA San Diego Healthcare System, she has had the opportunity to work in several different services involved with clinical and research programs. She started with the VA as a work-student in 1998 assisting HR with filing and organizing recruit personnel records and conducting other various administration tasks.

In February 2000, she was hired as a secretary assigned to the Medicine Service – Endocrinology Section. She was in charge of coordinating the section’s weekly Grand Rounds and Diabetes Meetings. Beatriz managed the Inter-Personnel Assignment (IPA) agreements and was the primary timekeeper for the section. She was also responsible for the input of requests for purchases of supplies, equipment and services on the Credit Card purchase system and monitored the funds available for obligation.

Beatriz was later hired to the San Diego MIRECC in July 2006. She currently maintains employee personnel records, prepares personnel actions, performance appraisals and all correspondence relating to personnel matters. She acts as a liaison and coordinates activities between the UCSD Psychiatry Department and the VASDHS as well as managing the IPAs and serving as the primary timekeeper. In addition, she has the responsibility of inventorying all the property and equipment assigned to the San Diego MIRECC.

**Summer Sports Clinic Kicks Off in San Diego, CA**

by Robert L. West

Days before the inaugural National Veterans Summer Sports Clinic (NVSSC) was set to kick off in San Diego, CA, 62 veterans representing 24 different states arrived to sunny skies, while over 100 volunteers and staff geared up to put on a training no one will soon forget.

MIRECC employee, Robert West feels fortunate to have been involved in this week long pilot program which was hosted by the VA San Diego Healthcare System, and was established after the National Veterans Winter Games in Denver, CO.

The five separate venues included the activities: Kayaking, Sailing, Surfing, Biking, and Track and Field. Enthusiastic coaches, instructors, volunteers and support staff were involved to make sure each veteran could adequately adapt to the sporting event of the day. Robert was the site coordinator of the Track and Field venue located at the world class Olympic Training Facility, Chula Vista, CA.

Almost every participating athlete was recently injured during their tour in Iraq or Afghanistan. Their various injuries included: traumatic brain injury, amputations, visual impairment, and post-traumatic stress disorder.

The goal of the Clinic was to expose veterans to the many adaptive methods available to them so they could enjoy activities they had before their injury and have the opportunity to try out new ones. The veterans not only received instructions on each sport, but learned stress management and coping skills that will help them adapt to life after injury.

The Clinic was a wonderful testament to the great work done at VAs across the country. The collaboration of skills from the various VA sites helped make this inaugural Summer Sports Clinic a fun and rewarding event for all who took part.

The NVSSC ran from September 29 to October 3, 2008 and is expected to be an annual event.
All four VISNs chose to focus on implementation of services to improve employment and weight. Supported Employment is an evidence-based practice that substantially increases rates of competitive employment. Wellness counseling and medication changes are evidence-based practices that lead to decreased weight.

EQUIP helps medical centers identify veterans with schizophrenia who would benefit from supported employment and wellness counseling. To do this they developed (and previously tested) the Patient Assessment System (PAS). The PAS is a web-based kiosk system similar in some ways to those used at airports. When presenting to the mental health clinic, the veteran sits down, puts on headphones and uses a touch screen computer. The PAS displays and reads aloud questions regarding current functional and symptom status, weight (there is a scale next to the kiosk), and interest in treatment preferences. The PAS prints a report that includes educational material. The veteran takes the report to their psychiatrist, who makes the appropriate referrals or medication adjustments. The printout also allows the veteran to track their own progress over time and to advocate for their own service needs.

EQUIP helps sites improve access to supported employment and wellness counseling. Trainings and materials are provided to clinicians to start wellness counseling programs and to support appropriate medication changes. Sites make use of data from the PAS to support quality managers and an evidence-based quality improvement process. Quality managers identify the population of veterans who could benefit from services, work with clinicians to ensure veterans get access to needed services, and address organizational barriers to service provision.

EQUIP works with leadership to ensure that services are available and utilized. At two sites, supported employment coaches have caseloads at or near capacity. In these cases, VISN and medical center leadership have worked to expand capacity, including hiring of coaches based on the numbers of interested veterans. EQUIP also helps leadership provide education and support through reports on quality of care across the whole clinic by clinician and regular reports on implementation and use of supported employment and wellness. EQUIP research includes a summative evaluation of the extent to which implementation efforts improve treatment appropriateness and veteran outcomes. It also includes systematic process evaluations to characterize causal mechanisms underlying observed changes and to identify barriers and facilitators to change. Once completed in 2009, EQUIP will provide information that can be used to strengthen implementation of recovery-oriented and evidence-based services and to ensure that veterans in specialty mental health settings are able to take full advantage of the latest treatments to improve their outcomes.

**Fellowship Program News**

*Where are they now?*

This segment has been postponed. We hope to resume interviewing past MIRECC 22 Fellowship program participants in the next issue.

For more information about the MIRECC 22 Fellowship program visit:

http://www.mirecc.va.gov/mirecc-fellowship.asp

Psychiatry Contact: Jonathon Meyer, MD, 858-552-8585, ext. 3570

Psychology Contact: Lisa Eyler, Ph.D., 858-552-8585, ext. 7666
The statistics talks, as neatly characterized by SIStat senior statistician Gerhard Hellemann, focused on the distinctions between three approaches to analyzing data: hypothesis testing, data mining, and modeling. Dr. Hellemann spoke about classification and regression trees (CART), hierarchical linear models (HLMs) and structural equation models (SEMs). Dr. Sugar provided an introduction to cluster analysis and functional data analysis (FDA). Dr. Gang Li, a professor in the UCLA statistics department and member of SIStat, discussed philosophy of hypothesis testing, longitudinal mixed models and survival analysis. For each of the talks, a MIRECC investigator used his or her own data to illustrate a problem and an analytical expert provided an overview of methods for understanding the data. Presentations spanned the breadth of MIRECC research from basic science to health services.

Dr. Alison Brown speaking on qualitative data approaches using EQUIP as her example.

The treatment unit supports the training program of interviewers on diagnostic interviews and symptom rating scales.

Treatment Unit

Los Angeles is the coordinating site for this four-site study that will evaluate potential functionally meaningful co-primary for use in clinical trials.

Regarding behavioral and psychosocial interventions, the Treatment Unit supports several funded research projects, including: 1) two studies of errorless learning and vocational training and job placement, 2) a study of motivational interviewing to improve vocational outcome, 3) a new study of cognitive-behavior therapy to reduce psychotic symptoms, and 4) a study that compares cognitive remediation exercises with social cognition training. Aside from these externally funded research projects, the Treatment Unit supports the training program of interviewers on diagnostic interviews and symptom rating scales.

Data Core Unit

The Data Core is also committed to an educational and mentoring role. We are available to consult with MIRECC fellows on both existing projects and new proposals including review of and assistance with Pala grants. In addition Data Core staff can provide didactic instruction in statistical packages and analytic techniques. Most recently, at the MIRECC annual meeting, Data Core faculty presented a series of lectures showcasing the spectrum of statistical thinking from hypothesis testing to modeling to data mining. Topics included cluster analysis, CART, mixed effects, longitudinal and hierarchical models, and functional data analysis.

These presentations have already resulted in new contacts with young fellows and faculty members around VISN 22 and we look forward to many exciting collaborations.

MIRECC personnel who wish to consult with Data Core faculty or staff can e-mail Dr. Sugar at csugar@ucla.edu or call the Data Core/SIStat main office at (310) 825-6584 and ask to speak to Drs. Sugar or Sun Hwang.
**Quick Tip: More E-mail Storage Space**

In this age where most of our correspondence is done through e-mail, it is becoming more and more important to have a place where electronic records can be kept. The amount of dedicated disk space is also becoming an issue and alerts are often sent from the system telling us that we've exceeded the allowable space and must delete files. To solve this problem we can create a personal directory on our VA "Home" drive.

**Procedure:** Open Microsoft Outlook (2003 or 2007). From the Toolbar select View > Navigation Pane. Then select File > Data File Management > Add > Select Office Outlook Personal Folders File (.pst) > select your VHA home drive (should be default) to save the folder in > Give the file a name > Save as type "personal folders file" > OK.

*Under Create Microsoft Personal Folders you can customize the folder with an individualized name, encryption and password. This can always be changed later under Data File Management > Settings.*

Look under your Navigation Pane under All Mail Folders for the file you created. You can now move folders and save needed folders into this larger drive for future reference.

*Note: For local computer issues contact your Information Technology Service.*

---

**Upcoming Events:**

**Social Skills Training**

~October 30-31, 2008
~Location: Westin Hotel, Long Beach
~Shirley Glynn, Ph.D., 310-268-3939

---

**In the next issue...**

- Social Skills Training Review
- Recurring Series:
- Unit Reviews
- Fellowship Program
- Spotlight on MIRECC Staff
Mental Illness Research, Education and Clinical Center
VA Desert Pacific Healthcare Network
Long Beach VA Healthcare System
Education and Dissemination Unit 06/116A
5901 E. 7th Street
Long Beach, CA 90822

Director
Stephen R. Marder, MD

Director, Education and Dissemination Unit
Christopher Reist, MD

MindView Questions or Comments
Robert L. West, 858-552-8585 x7650, Robert.West3@va.gov

VISIT US ON THE INTERNET AT:
www.desertpacific.mirecc.va.gov